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1 INTRODUCTION 
 
Deposition is software for evaluating penetration of aerosol through aerosol sampling 
systems.   The Deposition Calculator version 1.0 represents a complete rebuild of the 
software using an object-oriented design.  
 
2 PROGRAM BASICS 
 
2.1 System requirements 
 
Deposition Calculator requires a computer running Windows 7, Windows 8 or Windows 10. 
 
2.2 Installing and starting Deposition for Windows 
 
Deposition Calculator is compiled into a single executable file. Installation simply involves 
moving the file DepoCal.exe to the folder that the user desires. The program defaults to this 
folder when a file is saved. Double-click the Deposition Calculator icon to launch the 
program.   
 
2.3 Transport system definition 
 
An aerosol transport system is a collection of flow components such as tubes, bends, and 
probes that allows for the extraction and conveyance of an aerosol sample from one location 
to another. The term sample line is often used interchangeably with the term transport 
system. Deposition Calculator software allows the user to analyze a model of a transport 
system or sample line to determine the fraction of particles of a given size that are conveyed 
from the system inlet to the outlet, otherwise known as the sampling efficiency or particle 
penetration. Typically, some fraction of particles will be lost to the walls of the system due to 
mechanisms such as gravitational sedimentation, diffusion, or inertial impaction. In 
Deposition Calculator, a transport system is represented by a linked list of components that 
represent the mechanical elements of the physical transport system. Only transport 
components that have published efficiency models are represented in Deposition Calculator.  
Actual transport systems may contain features or exhibit deposition mechanisms (e.g. 
electrostatic deposition) that are not modeled by Deposition Calculator.  Failure to accurately 
model the physical system may lead to prediction of transport efficiency that does not match 
that of the physical system.  
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2.4 Basic Screen Navigation 
 
The Deposition Calculator screen is divided into 7 primary sections as depicted below in 
Figure 1. 
 

 
Figure 1: Primary screen layout 

 
 
2.4.1 Main Menu 
This section is used for general functions related to the entire program. 
 
2.4.2 Sample Line Name 
The Sample Line Name is an editable field. The user can name the transport system here. 
 
2.4.3 New Component Menu 
The New Component Menu is used to select a new component for the sample line. The new 
component will be placed at the end of the sample line. The user can move the new 
component with the EDIT menu item.  
 
2.4.4 Total System Results 
The percent penetration for the entire sample line is presented here. The transport efficiencies 
(Transmission) of the individual components are presented in the Individual Component Data 
section. The transmission is the percent penetration given in decimal format or simply the 
percent penetration divided by 100. In the default case, the results are based on a 
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monodispersed particle size of 10 µm Aerodynamic Equivalent Diameter (AED)1. ANSI 
N13.1-1999/20112 requires that at least 50% of the 10 µm AED particles entering the 
transport system penetrate the system to the sample collector.  
 
When the total transport system penetration is greater than 50%, the value will be green. 
Once the penetration is either equal to or less than 50%, the value turns red. This provides a 
visual indicator of compliance with ANSI N13.1-1999/2011. 
 
2.4.5 Individual Component Data panel 
This section is used to tabulate the components in the sample line. The Index is used in the 
Edit menu items. The particle transmission for each individual component is presented in the 
section. Other component data such as the inlet diameter, outlet diameter, temperature, length 
of a tube section, bend angle and bend radius are also available in this section. 
 
2.4.6 Current Component Data panel 
This section is used to input the Component specific data. Fields that have a blue background 
are considered global fields. Changes to a blue field will affect the same change in all 
Components; e.g. changing the Absolute Pressure from 101 to 90 in one Component would 
force that same change in all Components. A change in Internal Diameter will force a change 
in all Components, however if an expansion or contraction is included in the sample line, the 
program will use the ratio of inlet to outlet to effect the change for those components. In this 
case the program will notify the user to check the outlets of those components. 
 
2.4.7 3D Graphic Display 
This section provides a 3-Dimensional (3D) Graphic Display that can be rotated as needed. It 
contains an x, y, z indicator that is always available for orientation purposes. 
 
  

                                                
1 AED is the diameter of a sphere, with density = 1 g/cm3, that has the same terminal settling velocity under gravity as the 
airborne particle being considered. 
2 American National Standard – Sampling and Monitoring Releases of Airborne Radioactive Substances from the Stacks 
and Ducts of Nuclear Facilities, Health Physics Society, 1999/2011 
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3 CREATING A TRANSPORT SYSTEM 
 
3.1 New Sample Line 
 
As shown below in Figure 2, selecting New Sample Line under File menu item of the Main 
Menu creates a new sample line or transport system  
 

 
Figure 2: New sample line menu item 

 
The New Sample Line menu item clears all three panels of the primary User Interface (UI) of 
any components and associated data. The only object that should appear is the x, y, z axis 
indicator on the 3D graphic display. When the New Sample Line menu item is selected the 
user is prompted to save the existing sample line data. 
 
A default sample line name of “Sample Line 1” is populated for every new sample line. The 
user can replace this default sample line name with another name. 
 
Components are added by clicking on a component name in the New Component Menu. Any 
time a new component is added to the transport system four actions occur: 
 

1. A new line is added to the Individual Component Data panel. Details of this panel are 
provided in Section 4.1. 

2. The Component Data panel displays the default information for the component. This 
pane is where the user would make changes to the component properties. Details for 
each component are presented below in this section. 

3. The 3D Graphic Display is updated to reflect the new component. More details on the 
graphical display are provided in Section 4.3. 

4. The Total System Results are updated. 
 
 

Note 
When a probe or nozzle is included in the transport system, it must be selected as the first 
item. A probe or nozzle cannot be added after any other component. If the probe or nozzle is 
not included as the first component in the transport system, then the only solution is to start a 
new sample line. 



Deposition Calculator  User Guide 

Copyright 2015 – Brent Blunt 5 BC-15-RP-002 

 
3.2 Component Data panel 
 
The Component Data panel has three tabs; the Component tab, the Flow tab and the Fluid 
tab. An example of each is shown as Figure 3. The Component tab has data that the user can 
change, while the other two tabs provide information from calculations done by the software 
based on the properties of the component.  
 

Note 
The TAB Key should not be used navigate in the Component tabs. The RETURN or ENTER 
key and the ARROW keys work just fine. Also moving the mouse curser and clicking in a data 
entry box also is an acceptable form of navigation. 
 
The text boxes in the Component tab are color-coded. A yellow color indicates that the data 
is specific to that one component. A light blue color indicates that changes to that data will 
reflect a similar change for all components. For example, the Tube Internal Diameter 
should not change unless an Expansion or Contraction component is added to transport 
system. Therefore, once the Tube Internal Diameter is set, it will be the default for the 
next component. If the Tube Internal Diameter is changed at any component, the Tube 
Internal Diameter will change in all components before and after that component. A 
change in the Tube Internal Diameter will affect the Tube Internal Diameter of 
components after an Expansion or Contraction component, however the details of those 
changes is discussed more fully in the Expansion and Contraction sections of this manual. 
Similarly the Sample Flow Rate and Absolute Pressure parameters remain constant 
throughout the transport system. 
 
Most of the parameters in the Component tab can take data in either Systeme International 
d’Unites (SI) or American units. The units are selected with Radio buttons. The user is 
cautioned that changing units by selecting a new Radio Button will not change the value in 
the number boxes. The use must manually change both the value and the Radio Button. For 
example, if the Tube Length is set to 1 meter (m) and the user selects the feet (ft) Radio 
Button, the value of the Tube Length will not change to 3.28 but will remain at 1 ft. until the 
user enters a new value. 
 
The Flow tab provides data that the designer will find useful. The flow characteristics at the 
inlet of the component and at the outlet of the component are presented. For most 
components these values will be the same, however for the Expansion, Contraction, 
Shrouded Probe, and Nozzle components, the Mean Cross-Section Velocity and the 
Flow Reynolds Number values will differ between the inlet and outlet. 
 
The Fluid tab provides the designer with the basic fluid properties used in the model. These 
fluid properties are based on the temperature and pressure of the sampling system. 
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Figure 3: Component data tabs 
 
 
Each component type is discussed below in the order that it appears in the New Component 
Menu. 
 
3.3 Tube component 
 
The Tube menu item can have the following properties, which can be changed by the user in 
the Current Component Data panel. Note that a Tube component is named with a “T” and a 
sequential number beginning at 1. For example the first Tube component in the transport 
system would be named “T-1” and the second Tube component would be named “T-2”, and 
so on. 
 
 

Tube Length: The length of a straight section of sample tube. Units are either 
meters or feet. 
 

Inclination from 
horizontal: 

The angle that the axis of the component inlet makes with a 
horizontal reference plane (Figure 4. A negative inclination 
indicates the inlet flow is upward with respect to the vertical, 
positive inclination indicates the flow is downward. The 
inclination angel is given in degrees. Important cases include: 

• vertically downward: inclination angle = 90°  
• vertical upward: inclination angle = -90°  
• horizontal, flow to the left: inclination angle = 0° 
• horizontal, flow to the right: inclination angle = 180° 
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Tube Internal 
Diameter: 

The diameter of the internal surface of the tube. Units are 
either millimeters (mm) or inches (in). 
 

Sample Flow Rate 
(actual): 

The volumetric flow rate of the air at the component inlet at 
the temperature and pressure of the component. Units are 
either liters per minute (LPM) or cubic feet per minute (CFM).  
 

Temperature: The temperature of airflow in the component. This can change 
for systems that are heat traced or that travel outside of a 
controlled environment. When a straight tube penetrates a 
barrier and a temperature change occurs, the user can split the 
sample tube into two Tube components and set separate 
temperature for each component. Units are either degrees 
Centigrade (C) or degrees Fahrenheit (F). 
 

Absolute Pressure: The absolute pressure of the air in the component will typically 
be either ambient or just below ambient. Slight changes will 
have little effect on the deposition results. Units are either kilo 
Pascal (kPa) or pounds per square inch (psi). 
 

 
 

 
Figure 4: A tube at various inclination angles 
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3.4 Bend component 
 
The Bend menu item can have the following properties, which can be changed by the user in 
the Current Component Data panel. Note that a Bend component is named with a “B” and a 
sequential number beginning at 1. For example the first Bend component in the transport 
system would be named “B-1” and the second Bend component would be named “B-2”, and 
so on. 
 
 

Bend Angle: The angle through which the flow turns in flowing through the 
bend.  Valid bend angles are from 0° to 180°.  In the latter 
case, the flow would be redirected in the direction opposite 
from which it entered the bend.  The default value for bend 
angle is 90°. Units are in degrees. 
 
Examples are 
 

 
Bend Radius: The radius of curvature of the bend path measured from the 

center of the bend arc to the midline of the bend tubing. Note 
that the bend radius should be at least four times the tube 
internal diameter. 

 

 

90
° 

45
° 

180
° 

R = bend radius 
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Bend Orientation: This property defines the direction the outlet flow relative to 
the inlet.  The bend orientation is defined relative to the 
direction perpendicular to the inlet plane of the flow entering 
the bend.  A bend orientation of 0° indicates the bend is 
vertically upward relative to the inlet direction, a bend 
orientation of 90° indicates that the bend is right of the inlet 
direction, 180° indicates the bend is vertically downward, and 
-90° indicates that the bend is left of the inlet direction. Bend 
orientation can be best understood by considering the 
special case of a bend having an inclination angle of 0° (the 
inlet flow direction is horizontal) and a bend angle of 90° (a 
right-angle bend).  In this case a bend orientation of 0° 
will result in the outlet flow being vertically upward.  A bend 
orientation of 90° will result in the outlet flow remaining 
horizontal, but making a right turn relative to the path of the 
inlet flow.  A bend orientation of -90° would result in the 
outlet flow also remaining in the horizontal plane, but making 
a left turn relative to the inlet flow.  Lastly, a bend 
orientation of 180° will result in the outlet flow direction to 
be vertically downward. 
 

 
 

Inclination from 
horizontal: 

The angle that the axis of the component inlet makes with a 
horizontal reference plane (Figure 4). A negative inclination 
indicates the inlet flow is upward with respect to the vertical, 
positive inclination indicates the flow is downward. The 
inclination angle is given in degrees. Important cases include: 

• vertically downward: inclination angle = 90°  
• vertical upward: inclination angle = -90°  
• horizontal, flow to the left: inclination angle = 180° 
• horizontal, flow to the right: inclination angle = 0° 

 
Note that for the Bend component the horizontal direction 
is a mirror image of all other components. 
 

Tube Internal 
Diameter: 

The diameter of the internal surface of the tube. Units are 
either millimeters (mm) or inches (in). 
 

Inlet plane of 
bend 

-60° Outlet plane of 
bend 
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Sample Flow Rate: The volumetric flow rate of the air at the component inlet at 
the temperature and pressure of the component. Units are 
either liters per minute (LPM) or cubic feet per minute (CFM).  
 

Temperature: The temperature of air flow in the component. Units are either 
degrees Centigrade (C) or degrees Fahrenheit (F). 
 

Absolute Pressure: The absolute pressure of the air in the component will typically 
be either ambient or just below ambient. Slight changes will 
have little effect on the deposition results. Units are either kilo 
Pascal (kPa) or pounds per square inch (psi). 
 

 
 
3.5 Contraction component 
 
The Contraction menu item can have the following properties, which can be changed by the 
user in the Current Component Data panel. Note that a Contraction component is named 
with a “C” and a sequential number beginning at 1. For example the first Contraction 
component in the transport system would be named “C-1” and the second Contraction 
component would be named “C-2”, and so on. 
 
 

Inlet Internal 
Diameter: 

The diameter of the internal surface of the inlet. Units are 
either millimeters (mm) or inches (in). 
 



Deposition Calculator  User Guide 

Copyright 2015 – Brent Blunt 11 BC-15-RP-002 

Outlet Internal 
Diameter: 

The diameter of the outlet of the contraction. Units are either 
millimeters (mm) or inches (in). 
 
By definition, a contraction must have outlet diameter less than 
inlet diameter. By default Deposition Calculator sets the initial 
outlet internal diameter to 1/1.5 of the inlet diameter. 
The user can change the outlet internal diameter to 
match the actual component in the transport system. Note that 
this new ratio is used by Deposition Calculator to estimate a 
new outlet diameter of the Contraction and all additional 
downstream components should the internal diameter of a 
upstream component be changed during later edits. Similarly, 
Deposition Calculator will use this new ratio to set the internal 
diameter of the Contraction and all upstream components if 
the internal diameter of a component downstream of the 
contraction is changed during later editing. Therefore, user 
should always check the internal diameter of components 
upstream and downstream of a Contraction component to 
ensure the internal diameter is correct. An easy way to make 
corrections is at the Contraction component by setting the 
Inlet Diameter and the Outlet Diameter to the correct 
values. This will result in all components both upstream and 
downstream of the Contraction component being set to the 
correct internal diameter. 
 
 

Contraction Half 
Angle: 

The angle of taper of the Contraction. Allowable values are 
from 0° to 90°. Note that a 90° contraction angle should be 
used when tubes of different diameters are joined in a butt-
weld or counter-bore configuration. The Contraction Half 
Angle is given in degrees. 
 

 
 

30° 
45
° 90° 
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Inclination from 
horizontal: 

The angle that the axis of the component inlet makes with a 
horizontal reference plane (Figure 4). A negative inclination 
indicates the inlet flow is upward with respect to the vertical, 
positive inclination indicates the flow is downward. The 
inclination angle is given in degrees. Important cases include: 

• vertically downward: inclination angle = 90°  
• vertical upward: inclination angle = -90°  
• horizontal, flow to the left: inclination angle = 0° 
• horizontal, flow to the right: inclination angle = 180° 

 
Sample Flow Rate 
(actual): 

The volumetric flow rate of the air at the component inlet at 
the temperature and pressure of the component. Units are 
either liters per minute (LPM) or cubic feet per minute (CFM).  
 

Temperature: The temperature of airflow in the component. Units are either 
degrees Centigrade (C) or degrees Fahrenheit (F). 
 

Absolute Pressure: The absolute pressure of the air in the component will typically 
be either ambient or just below ambient. Slight changes will 
have little effect on the deposition results. Units are either kilo 
Pascal (kPa) or pounds per square inch (psi). 
 

 
 
3.6 Expansion component 
 
The Expansion menu item can have the following properties, which can be changed by the 
user in the Current Component Data panel. Note that a Expansion component is named with 
an “E” and a sequential number beginning at 1. For example the first Expansion component 
in the transport system would be named “E-1” and the second Expansion component would 
be named “E-2”, and so on. 
 
 

Inlet Internal 
Diameter: 

The diameter of the internal surface of the inlet. Units are 
either millimeters (mm) or inches (in). 
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Outlet Internal 
Diameter: 

The diameter of the outlet of the expansion. Units are either 
millimeters (mm) or inches (in). 
 
By definition, an expansion must have outlet diameter greater 
than inlet diameter. By default Deposition Calculator sets the 
initial outlet internal diameter to 1.5 times the inlet 
diameter. The user can change the outlet internal 
diameter to match the actual component in the transport 
system. Note that this new ratio is used by Deposition 
Calculator to estimate a new outlet diameter of the Expansion 
and all additional downstream components should the internal 
diameter of a upstream component be changed during later 
edits. Similarly, Deposition Calculator will use this new ratio 
to set the internal diameter of the Expansion and all upstream 
components if the internal diameter of a component 
downstream of the contraction is changed during later editing. 
Therefore, user should always check the internal diameter of 
components upstream and downstream of an Expansion 
component to ensure the internal diameter is correct. An easy 
way to make corrections is at the Expansion component by 
setting the Inlet Diameter and the Outlet Diameter to the 
correct values. This will result in all components both 
upstream and downstream of the Expansion component being 
set to the correct internal diameter. 
 
 

Expansion Half 
Angle: 

The angle of taper of the Expansion. Allowable values are 
from 0° to 90°. Note that a 90° expansion angle should be used 
when tubes of different diameters are joined in a butt-weld or 
counter-bore configuration. The Expansion Half Angle is 
given in degrees. 
 

 
 

30° 
45
° 90° 
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Inclination from 
horizontal: 

The angle that the axis of the component inlet makes with a 
horizontal reference plane (Figure 4). A negative inclination 
indicates the inlet flow is upward with respect to the vertical, 
positive inclination indicates the flow is downward. The 
inclination angle is given in degrees. Important cases include: 

• vertically downward: inclination angle = 90°  
• vertical upward: inclination angle = -90°  
• horizontal, flow to the left: inclination angle = 0° 
• horizontal, flow to the right: inclination angle = 180° 

 
Sample Flow Rate 
(actual): 

The volumetric flow rate of the air at the component inlet at 
the temperature and pressure of the component. Units are 
either liters per minute (LPM) or cubic feet per minute (CFM).  
 

Temperature: The temperature of airflow in the component. Units are either 
degrees Centigrade (C) or degrees Fahrenheit (F). 
 

Absolute Pressure: The absolute pressure of the air in the component will typically 
be either ambient or just below ambient. Slight changes will 
have little effect on the deposition results. Units are either kilo 
Pascal (kPa) or pounds per square inch (psi). 
 

 
 
3.7 Shrouded Probe component 
 
The Shrouded Probe menu item can have the following properties, which can be changed 
by the user in the Current Component Data panel. Note that a Shrouded Probe component 
is named “N-1”. There can only be one Shrouded Probe or Nozzle in a Transport System and 
the Shrouded Probe must be the first item in transport system. It cannot be added later during 
the edit process. 
 
ANSI N13.1-1999/2011 requires that the Aspiration Ratio be between 0.8 and 1.5. The 
Aspiration Ratio is the ratio of the aerosol concentration at the nozzle inlet plane divided by 
the aerosol concentration in the undisturbed stream at the point where the nozzle is located. 
This value is presented at the top of the Shrouded Probe tab, along with the ANSI limits. 
When the Aspiration Ratio is within limits the value is green and when it is out of limits it is 
red. 
 
Shrouded probes models are available for three commercial probes (RF2-111, RF2-112, and 
RF2-113), and three Department of Energy-designed probes (CMR4CFM-HI, CMR4CFM-
MI, WIPP6CFM).  The geometric information used by Deposition Calculator for each probe 
type is coded in the Calculation modules. 
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Sample Flow Rate 
(actual): 

The volumetric flow rate of the air at the component inlet at 
the temperature and pressure of the component. Units are 
either liters per minute (LPM) or cubic feet per minute (CFM).  
 

Free Stream 
Velocity: 

The velocity of the free stream flow at the location of the 
nozzle placement. The model assumes that the direction of the 
free stream flow and the nozzle inlet plane perpendicular are 
equal (isoaxial sampling condition). Units are either meters per 
second (m/s) or feet per second (ft/s) 
 

Inclination from 
horizontal: 

The angle that the axis of the component inlet makes with a 
horizontal reference plane (Figure 4). A negative inclination 
indicates the inlet flow is upward with respect to the vertical, 
positive inclination indicates the flow is downward. The 
inclination angel is given in degrees. Important cases include: 

• vertically downward: inclination angle = 90°  
• vertical upward: inclination angle = -90°  
• horizontal, flow to the left: inclination angle = 0° 
• horizontal, flow to the right: inclination angle = 180° 

 
Temperature: The temperature of air flow in the component. Units are either 

degrees Centigrade (C) or degrees Fahrenheit (F). 
 

Absolute Pressure: The absolute pressure of the air in the component will typically 
be either ambient or just below ambient. Slight changes will 
have little effect on the deposition results. Units are either kilo 
Pascal (kPa) or pounds per square inch (psi). 
 

Probe Types: The six Shrouded Probes with test data are presented in this 
section. The user can select a probe by selecting a Radio 
Button. Note that the out diameter of the probe is given. In 
cases where the sample line is smaller or larger than the probe 
outlet, a Contraction or Expansion component should be 
used in the transport system to account for the change in 
internal diameters. 

 
 
3.8 Nozzle component 
 
The Nozzle menu item can have the following properties, which can be changed by the user 
in the Current Component Data panel. Note that a Nozzle component is named “N-1”. There 
can only be one Shrouded Probe or Nozzle in a Transport System and the Shrouded Probe 
must be the first item in transport system. It cannot be added later during the edit process. 
 
ANSI N13.1-1999/2011 requires that the Aspiration Ratio be between 0.8 and 1.5. The 
Aspiration Ratio is the ratio of the aerosol concentration at the nozzle inlet plane divided by 
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the aerosol concentration in the undisturbed stream at the point where the nozzle is located. 
This value is presented at the top of the Nozzle tab, along with the ANSI limits. When the 
Aspiration Ratio is within limits the value is green and when it is out of limits it is red. 
 

Inlet Internal 
Diameter: 

The diameter of the aspiration nozzle inlet facing the free 
stream flow. Units are either millimeters (mm) or inches (in). 
 

Outlet Internal 
Diameter: 

At present the nozzle model includes only straight-tube 
nozzles, therefore the diameter of the nozzle outlet should be 
the same as the inlet. At present the nozzle model does not use 
the Outlet Internal Diameter in the calculations. 
However the Nozzle Outlet Internal Diameter is used to 
select the Tube Inlet Diameter of the next component, 
which in many cases will be an Expansion component. Units 
are either millimeters (mm) or inches (in). 
 

Nozzle Length: The length of the nozzle tube, similar to length for a straight 
tube. Units are either millimeters (mm) or inches (in). 
 

Free Stream 
Velocity: 

The velocity of the free stream flow at the location of the 
nozzle placement. The model assumes that the direction of the 
free stream flow and the nozzle inlet plane perpendicular are 
equal (isoaxial sampling condition). Units are either meters per 
second (m/s) or feet per second (ft/s) 
 

Inclination from 
horizontal: 

The angle that the axis of the component inlet makes with a 
horizontal reference plane (Figure 4). A negative inclination 
indicates the inlet flow is upward with respect to the vertical, 
positive inclination indicates the flow is downward. The 
inclination angle is given in degrees. Important cases include: 

• vertically downward: inclination angle = 90°  
• vertical upward: inclination angle = -90°  
• horizontal, flow to the left: inclination angle = 0° 
• horizontal, flow to the right: inclination angle = 180° 

 
Sample Flow Rate 
(actual): 

The volumetric flow rate of the air at the component inlet at 
the temperature and pressure of the component. Units are 
either liters per minute (LPM) or cubic feet per minute (CFM).  
 

Temperature: The temperature of air flow in the component. Units are either 
degrees Centigrade (C) or degrees Fahrenheit (F). 
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Absolute Pressure: The absolute pressure of the air in the component will typically 
be either ambient or just below ambient. Slight changes will 
have little effect on the deposition results. Units are either kilo 
Pascal (kPa) or pounds per square inch (psi). 
 

 
 
3.9 Splitter component 
 
The Splitter is a special component in a transport system. The most common use in a 
transport system is allow for a single probe to be used to extract a sample and deliver that 
sample to both a media collection system, such as a filter paper, and to deliver the same 
sample to a sample device equipped with a detector.  
 
Deposition Calculator treats the Splitter component as an individual component that is not 
implemented in the 3-D Graphic Display area. The Splitter component is selected by 
clicking the Splitter menu item of the Main menu (Figure 5).  
 
 

 
Figure 5: Splitter menu item 

 
 
 
A new pop-up form is displayed for the Splitter component when the Splitter menu item is 
selected. (Figure 6) The only splitter that is programmed into Deposition Calculator is one 
that meets the geometrical dimensions of the drawing included in the Splitter form. Other 
splitter designs have not been implemented in this version of Deposition Calculator. 
 
The model in the Deposition Calculator can also be used to design the Splitter component. 
When the user enters the data in the Interactive Panel of the form, the model calculates the 
remaining geometric parameters required for the splitter design some flow characteristics and 
the percent transmission of the particles of interest. The geometric parameters and the flow 
characteristics are present below the Interactive Panel in the Design Information Panel and 
the component transmission, given as a percentage, is presented at the top of the form. 
This approach ensures that only a splitter that meets all the geometric conditions of those 
tested are analyzed with this model. There are some limitations to this splitter model, which 
are presented in the Limitation Panel. This splitter design also assumes that the flow rate out 
each leg of the split is equal.  
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Figure 6: Splitter form 

 
 
 
Once finished, the user should note the Transmission value, which would be applied to both 
legs of the split, and then select the Close button. At his time, there is not a print function for 
this form. If the user desires, a screen shot can be made using one of the programs designed 
for that purpose. 
 
 
The following parameters are found in the Interactive Panel: 
 

Inlet Flow Rate 
(actual): 

The volumetric flow rate of the air at the component inlet at 
the temperature and pressure of the component. Units are liters 
per minute (LPM).  
 

Bifurcation Angle: The angle between the legs of the splitter. Shown as q in 
Figure 6. Units are in degrees. 
 

Tube Internal 
Diameter: 

The diameter of the internal surface of the inlet. Units are 
millimeters (mm). 
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Temperature: The temperature of airflow in the component. Units are 
degrees Centigrade (C). 
 

Absolute Pressure: The absolute pressure of the air in the component will typically 
be either ambient or just below ambient. Slight changes will 
have little effect on the deposition results. Units are kilo Pascal 
(kPa). 
 

 
 
The following parameters are found in the Design Information Panel: 
 

Do: Theoretical 
Outlet Tube 
Diameter (mm): 

The diameter of the internal surface of the outlet. Generally 
the final component’s outlet tube diameter should be with 5% 
of this value. Units are millimeters (mm). 
 

Li: Minimum Inlet 
Tube Length (mm): 

The theoretical length of the inlet tube from the splitter 
entrance to the bifurcation angle. Generally the final 
component’s inlet tube length should be with 5% of this value. 
For values greater than 5%, the user should add a tube section 
to the transport system to account for the additional length. 
Units are millimeters (mm). 
 

L0: Minimum Outlet 
Tube Length (mm): 

The theoretical length of the outlet tube from the bifurcation 
angle to the outlet of the splitter. Generally the final 
component’s outlet tube length should be with 5% of this 
value. For values greater than 5%, the user should add a tube 
section to the transport system to account for the additional 
length. Units are millimeters (mm). 
 

Stokes Number: The Stokes number is presented here for comparison to the 
Model limitations section. The Stokes number should be 
within the limits of the model. 
 

Reynolds Number The Reynolds number is presented here for comparison to the 
Model limitations section. The Reynolds number should be 
within the limits of the model  
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4 ANALYSIS RESULTS 
 
As the transport system is being constructed Deposition Calculator provides transmission or 
penetration results with every new component and with any change to a component. The 
results are presented to the user by three methods, which are discussed below. 
 
4.1 Individual Component Data Panel 
 
Referring to Figure 1, the Individual Component Data Panel is located on the left side of the 
main UI. This panel provides data for each individual component of the transport system. 
The first four columns of this panel are displayed when Deposition Calculator begins, but 
there are a total of 10 columns. The units presented are those selected by the user for each 
parameter of that component. Therefore, both SI and English units may appear for any one 
component. When a parameter is not applicable for a particular component the value for that 
parameter is populated with an “NA”. An example of the data that would be present for the 
transport system shown in Figure 1 is presented below as Table 1.  
 

Table 1: Individual Component Data Panel for transport system depicted in Figure 1 
Index	 Component	 Type	 Transmission	 Tube	

Length	
Bend	
Angle	

Bend	
Radius	

Inlet	
Diameter	

Outlet	
Diameter	 Temperature	

0	 N-1	*	 RF2-111	 0.9500	 NA	 NA	 NA	 NA	 NA	 25.0	C	

1	 T-1	 Tube	 1.0000	 1.00	m	 NA	 NA	 38.10	mm	 38.10	mm	 25.0	C	

2	 B-1	 Bend	 0.9789	 NA	 90.00	Deg	 0.102	m	 38.10	mm	 38.10	mm	 25.0	C	

3	 T-2	 Tube	 0.8858	 1.00	m	 NA	 NA	 38.10	mm	 38.10	mm	 25.0	C	

4	 B-2	 Bend	 0.9789	 NA	 90.00	Deg	 0.102	m	 38.10	mm	 38.10	mm	 25.0	C	

5	 T-3	 Tube	 1.0000	 3.0	m	 NA	 NA	 38.10	mm	 38.10	mm	 25.0	C	

 
 
4.2 Total System Results 
 
Referring to Figure 1, the Total System Results Panel is located on the upper right side of the 
main UI. This value is the result of multiplying each individual Transmission value, as shown 
in the Individual Component Data Panel, by each other and then converting to a percentage. 
For this case: 
 
(0.9500)(1.0000)(0.9789)(0.8858)(0.9789)(1.0000) = 0.8064 or 80.64% 
 
As discussed in Section 2.4.4, ANSI N13.1-1999/2011 requires that at least 50% of the 10-
µm AED particles entering the transport system penetrate the system to the sample collector. 
This limit has been annotated in the Total System Results Panel as a reminder to the user. 
 
4.3 3D Graphic Display 
 
As a visual aid to the user a 3D graphic of the transport system is provided in the 3D Graphic 
Display area on the right of the main UI. The graphic can be rotated in any direction by first 
placing the cursor in the 3D Graphic Display area, then holding the left mouse button and 
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moving the mouse. The Redraw menu item can be used to return the graphic to a default 
presentation. 
 

 
Figure 7: Redraw menu item 

 
 
Note that the graphic is presented for visual affects only and is not always maintained to 
scale. The graphic can be printed, as will be discussed later in this manual. 
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5 MENU ITEMS 
 
The main menu (Figure 8) is located in the upper left side of the main UI. Each menu item is 
discussed in this section. 

 
Figure 8: Deposition Calculator Main menu 

 
 
 
5.1 File menu item 
 
The File menu item has 6 sub-menu items (Figure 9). 
 

 
Figure 9: File sub-menu items 

 
 

5.1.1 New Sample Line 
 
The New Sample Line sub-menu item is used to create a new sample line or 
transport system. When selected the New Sample Line sub-menu item clears all 
three panels of the primary UI of any components and associated data. The only 
object that should appear is the “x, y, z indicator” on the 3D graphic display. When 
the New Sample Line menu item is selected the user is prompted to save the 
existing sample line data. Additional detains are presented in Section 2.4.2 of this 
manual. 
 

5.1.2 Open File 
 
Previously saved transport systems can be re-opened for editing or analysis.  To 
open a previously saved transport system, select Open File submenu item, and 
migrate the open file dialog to the appropriate folder containing the transport 
system file.   
 



Deposition Calculator  User Guide 

Copyright 2015 – Brent Blunt 23 BC-15-RP-002 

5.1.3 Save 
 
Transport systems can be saved for later analysis or modification.  To save a 
transport system, select either the Save or Save As sub-menu item.  The Save sub-
menu item will save the file by overwriting any existing file with the current file 
name.  By default Deposition Calculator will save a file to the same director that it 
resides in. 
 

5.1.4 Save As 
 
Transport systems can be saved for later analysis or modification.  To save a 
transport system, select either the Save or Save As sub-menu item. The Save As 
sub-menu item allows the user to specify a new name for the file.  By default 
Deposition Calculator will save a file to the same director that it resides in. 
 

5.1.5 Print 
 
The Print sub-menu item can be used to print a Results Report or the drawing. Both 
of these printouts for the example transport system presented in Figure 1 are 
provided below as Figure 10 and Figure 11. 
 

 
Figure 10: Example printout of Results Report 
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Figure 11: Example transport system printout 

 
  

5.1.6 Exit 
 
The Exit sub-menu item can be used to close the program. Deposition Calculator 
can also be closed with the standard windows x-icon in the upper right corner of the 
window. 

 
 
5.2 Edit menu item 
 
Using the sub-menu items (see Figure 12) in the Edit menu the user can modify a 
components properties, move a component to a different location in the transport system, or 
completely delete a component form the transport system. 
 
 

 
Figure 12: Edit sub-menu items 

 
 
The following example illustrates how to change the length of component T-2 in the Figure 1 
example transport system form 1 meter to 2 meters in length.  
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Step 1 Determine the component to change. 

 
This is Component T-2; i.e. tube 
component number 2 in the transport 
system 
 

 
 

Step 2 Determine the Index number for the item. 
The index number can be found in the 
first column of the Individual Component 
Data panel.  
 
In this Case Index number = 3 
  

 
Step 3 Click on the Edit menu item and select 

the Edit Component sub-menu item. 
 

 
 

Step 4 A Pop-up window will appear where the 
Index number for the item is entered. In 
this case 3.  
Then click the Confirm Button. 
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Step 5 The Component tab for the component to 
be edited will be populated and will 
appear in the Current Component Data 
panel.  
 
Change the Tube Length to 2 meters. 
 

 
 

Step 6 The 3D graphic will indicate the change, 
as will the values for T-2 in the 
Individual Component Data Panel. Note 
that the Transmission has changed from 
0.8858 to 0.7795. 
 

 
 

 
 
 
 
The procedure to move a component follow the same procedure, except both the index 
number of the component to be moved and the index location where the component will be 
moved are required. 
 
The procedure for deleting a component only requires the index number of the component to 
delete. 
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5.3 Distribution menu item 
The default particle distribution is a monodispersed 10 µm AED particle. However, 
Deposition Calculator can determine particle penetration for any particle size of particle 
distribution. To change either the particle size or to set a particle distribution, use the 
Distribution menu item. 
 
When the Distribution menu item is clicked, a new pop-up window appears (Figure 13). 
 

 
Figure 13: Particle distribution form 

 
To change the particle size for a monodispersed, simply change the value in the 
Aerodynamic Particle Diameter field and leave the Monodispersed Radio Button 
checked. Click the Confirm button and the penetration analysis will be done with this new 
particle size. 
 
Should a polydipsersed particle distribution be desired, then click the Polydispered 
Lognormal button; enter the Geometric Mean Aerodynamic Particle Diameter and the 
Geometric Standard Deviation. A plot of this distribution is available by clicking the 



Deposition Calculator  User Guide 

Copyright 2015 – Brent Blunt 28 BC-15-RP-002 

Plot button. A plot of a distribution with a 5 µm Geometric Mean Aerodynamic Particle 
Diameter and a 1.9 Geometric Standard Deviation is shown in Figure 14. When the Confirm 
button is clicked on the Particle Distribution form, Deposition Calculator will determine the 
particle penetration for the new distribution. 
 
 

 
Figure 14: Lognormal particle distribution of a 5 µm geometric mean aerodynamic 

particle diameter and a 1.9 geometric standard deviation 
 
 
Particle sizes used in Deposition Calculator are based on the Aerodynamic Diameter (AD) 
concept, where the particles are assumed to be spherical in shape and have a density of 1000 
kg/m3. Conversion of other particle densities to the AD can be performed by the user with the 
following equation, which is not included in the Deposition Calculator code. 
 

𝐷"# = 	𝐷&
𝜌&

1000	𝑘𝑔/𝑚.

/.1
	

 
Where: 

DAD	 =	 aerodynamic	diameter	of	a	subject	particle,	m	
Di	 =	 actual	diameter	of	a	subject	particle,	m		
ri	 =	 	density	of	a	subject	particle,	kg/m3	
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For example: A facility uses 3 µm plutonium dioxide particles with a density of 11.5 g/cm3, 
what is the aerodynamic diameter that should be used in Deposition Calculator. 
 
 

	DJK = 	DL
ρL

1000	kg/m.

/.1
 

 

DJK = 	 3	𝜇𝑚 1E-06	m/𝜇𝑚
11.5	𝑔/𝑐𝑚. 1000	 𝑘𝑔/𝑚

.

𝑔/𝑐𝑚.

1000	kg/m.

/.1

 

 
DJK = 1.02E-06	m	 
 
 
or 10.2 µm. 
 
This indicates that a 3 µm particle with a density of 11.5 g/cm3 settles at the same velocity as a 
10.2 µm particle with a density of 1 g/cm3.  
 

 
5.4 Studies menu item 
 
Deposition Calculator has the ability to perform studies where a particular parameter is 
varied to determine the affect on transport system performance. The Studies menu item is 
used to get to these studies. When the Studies menu item is selected a new pop-up window 
appears (Figure 15). There are three parameters that can be varied: Tube Diameter, Flow rate, 
and Particle size. For the particle size study, only monodispersed particle distributes are 
allowed. 
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Figure 15: Variable parameters form 

 
 
 
 
To perform a study, the user would select the study desired by clicking the appropriate radio 
button. Then enter the Initial Value, the Final Value and the Number of Intervals to 
evaluate. Using the example transport system for Figure 1, the follow plots are obtained for 
each type of study. The Initial Value, Final Value and Number of Intervals are 
given in the caption for each plot. 
 
Upon closing the plot window, the data used to generate the plots can be saved to a ‘.csv’ 
file. A ‘.cvs’ file is a comma delimited file that can be opened in various spreadsheet and text 
programs. 
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Figure 16: Vary tube size: Initial value =1 mm, Final value = 50 mm, 50 intervals 

 
 

 
Figure 17: Vary flow rate: Initial value = 10 LPM, Final value 100 LPM, 50 intervals 
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Figure 18: Vary particle size: Initial value = 0.5 µm, Final value 25 µm, 50 intervals 

 
 
 
5.5 Splitter menu item 
 
This menu item is discussed in detail in Section 3.9 of this manual. 
 
5.6 Redraw menu item 
 
As discussed in Section 4.3 of this manual, the Redraw menu item returns the 3D graphic to 
a default orientation. After manipulating the graphic, it is much fast to return to the starting 
orientation with this menu item. 
 
5.7 Help menu item 
 
The Help menu item currently only provides information, such as version number and 
copyright information. 
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6 TEST CASES 
 
Two test cases are provided in this manual. These test cases can be used to validate that the 
Deposition Calculator software is operating correctly. 
 
6.1 Test Case 1 
 
Test case 1 is a simple transport system very similar to that shown in Figure 1 of this manual. 
A contraction has been added at the end of the vertical tube to accommodate the entry into an 
alpha monitor, which requires a 1-inch (25.4 mm) tube. The alpha monitor would be 
analyzed separately. 
 
6.1.1 Description of transport system 
 
In this case study, the sampling system extracts aerosol particles from a vertical stack having 
a free stream velocity of 10 m/s, where the average temperature in the stack is 25 °C, and an 
absolute pressure 101 kPa.  Particles having an aerodynamic diameter of 10 µm are extracted 
from the stack using an RF2-111 shrouded probe with a sample flow rate of 57 L/min (2 
CFM). The probe is connected to a 1 m vertical tube before being redirected horizontally in a 
sweep elbow having a bend radius of 0.2 m. The sample flow continues through a horizontal 
tube having a length of 1 m through a port in the stack wall.  Upon exit from the stack, the 
sample line is redirected vertically downward with a 90° elbow having a bend radius of 0.2 
m.  The sample continues down a 3 m sample line to a contraction. The contraction has a half 
angle of 45° and the exit diameter is 25.4 mm. 
 
6.1.2 Modeling the system in Deposition Calculator 
 
The Deposition Calculator component entry tab for each component is presented in Table 2. 
 



Deposition Calculator  User Guide 

Copyright 2015 – Brent Blunt 34 BC-15-RP-002 

Table 2: Component tabs for Case 1 
Index Item 0 

 

Index Item 1 

 

Index Item 2 

 

Index Item 3 

 

Index Item 4 

 

Index Item 5 
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Index Item 6 

 

  

 
 
The main Deposition Calculator form after entry of all components is presented as Figure 19. 
Note that the total particle penetration for Case 1 is 83.40%.  
 
 

 
Figure 19: Case 1 Deposition Calculator Screen after entry of all components 
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6.1.3 Results from Case 1 analysis 
 
Once all components are entered, the Individual Component Data Panel will be populated as 
shown in Table 3. 
 

Table 3: Individual Component Data Panel for Case 1 
Index	 Component	 Type	 Transmission	 Tube	

Length	
Bend	
Angle	

Bend	
Radius	

Inlet	
Diameter	

Outlet	
Diameter	 Temperature	

0	 N-1	*	 RF2-111	 0.9500	 NA	 NA	 NA	 NA	 NA	 25.0	C	

1	 T-1	 Tube	 1.0000	 1.00	m	 NA	 NA	 38.10	mm	 38.10	mm	 25.0	C	

2	 B-1	 Bend	 0.9970	 NA	 90.00	Deg	 0.200	m	 38.10	mm	 38.10	mm	 25.0	C	

3	 T-2	 Tube	 0.8856	 1.00	m	 NA	 NA	 38.10	mm	 38.10	mm	 25.0	C	

4	 B-2	 Bend	 0.997	 NA	 90.00	Deg	 0.200	m	 38.10	mm	 38.10	mm	 25.0	C	

5	 T-3	 Tube	 1.0000	 3.00	m	 NA	 NA	 38.10	mm	 38.10	mm	 25.0	C	

6	 C-1	*	 Contraction	 0.9974	 NA	 NA	 NA	 38.10	mm	 25.40	mm	 25.0	C	

 
The Results Report is presented as Figure 20. The user can check the Case 1 results by 
printing the Results Report from the File menu. 
 
 

 
Figure 20: Case 1 Results Report 
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6.2 Test Case 2 
 
Test Case 2 is a more complex system and demonstrates how to include an isokinetic sample 
nozzle, which has an increasing internal diameter. This case also demonstrates a transport 
system that has a penetration of less than 50% and would not meet the ANSI N13.1-
1999/2011 criteria. 
 
6.2.1 Description of transport system 
 
In this case study, the sampling system extracts aerosol particles from a vertical stack having 
a free stream velocity of 9 m/s, where the average temperature in the stack is 46 °C, and an 
absolute pressure 98 kPa. Particles having an aerodynamic diameter of 10 µm are extracted 
from the stack using an isokinetic nozzle with a sample flow rate of 56.6 L/min (2 CFM).  In 
order to accommodate the isokinetic condition, the nozzle inlet size must be 11.5 mm.  The 
sample flow at the nozzle exit is expanded to a diameter of 25.4 mm (1 inch) in a tapered 
expansion having an expansion angle of 30°. The extracted aerosol is then redirected 
horizontally in a sweep elbow having a bend radius of 0.15 m.  The sample flow continues 
through a horizontal tube having a length of 3 m through a port in the stack wall. Upon exit 
from the stack, the sample line is redirected in the horizontal plane through a bend angle of 
90° to avoid conflict with a support beam located just outside the stack wall. Finally, the 
sample line is redirected vertically downward with third 90° elbow having a bend radius of 
0.2 m. After exiting the final sweep elbow the particles are collected on a filter sampler.  In 
order to provide adequate face area of the filter sampler, the flow is expanded to a diameter 
of 95 mm just upstream of the filter surface (Figure 21). The 3D presentation of this sample 
line is presented below as Figure 22. Note that the expansion components appear as a tube 
with wings, where the wings expand in the direction of flow. 
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Figure 21: Internal flow path details of sample line connection to filter 
 
 

 
Figure 22: 3D presentation of Case 2 transport system 

 
 
6.2.2 Modeling the system in Deposition Calculator 
 
In order to model the physical system in Deposition, it is important to remember that 
physically continuous sample tubing or components may require more than one component 
for accurate representation. In the case considered here, the isokinetic nozzle will be modeled 
as two components: a short isokinetic nozzle (100 mm in length) and a tapered expansion.  
Both components are required in this case as the standard model for a sharp-edge sampling 
nozzle considers nozzles having parallel walls (inlet and outlet diameters equal).  Since in the 
physical system the flow is gradually expanded from 11.5 mm to 25.4 mm after aspiration, an 

25.4 mm 

95 mm 
Filter Surface 

Aerosol Flow 

30° 



Deposition Calculator  User Guide 

Copyright 2015 – Brent Blunt 39 BC-15-RP-002 

expansion model will be required.  In addition, the filter sampler must also include an 
expansion model since the flow path expands to 95 mm prior to collection of particles on the 
filter surface.  These two details may escape notice in the initial review of the physical 
system and illustrate the caution that must be exercised in developing a representative 
Deposition Calculation model.  The remaining components between the inlet and outlet 
require no special treatment. The Deposition Calculator component entry tab for each 
component is presented in Table 4. Note that the aspiration ratio for the nozzle is 1.00, which 
by definition is isokinetic.  
 
The main Deposition Calculator form after entry of all components is presented as Figure 23. 
Note that the total particle penetration for Case 2 is 32.57%.  
 
 

 
Figure 23: Case 2 Deposition Calculator Screen after entry of all components 
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Table 4: Component tabs for Case 2 
Index Item 0 

 

Index Item 1 

 

Index Item 2 

 
Index Item 3 

 

Index Item 4 

 

Index Item 5 
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Index Item 6 

 

  

 
 
 
 
 
6.2.3 Results from Case 2 analysis 
 
Once all components are entered, the Individual Component Data Panel will be populated as 
shown in Table 5. 
 

Table 5: Individual Component Data Panel for Case 2 
Index	 Component	 Type	 Transmission	 Tube	

Length	
Bend	
Angle	

Bend	
Radius	

Inlet	
Diameter	

Outlet	
Diameter	 Temperature	

0	 N-1	*	 Nozzle	 0.8861	 NA	 NA	 NA	 NA	 NA	 46.0	C	

1	 E-1	*	 Expansion	 0.5913	 NA	 NA	 NA	 11.50	mm	 25.40	mm	 46.0	C	

2	 B-1	*	 Bend	 0.9631	 NA	 90.00	Deg	 0.150	m	 25.40	mm	 25.40	mm	 46.0	C	

3	 T-1	*	 Tube	 0.7801	 1.00	m	 NA	 NA	 25.40	mm	 25.40	mm	 46.0	C	

4	 B-2	*	 Bend	 0.9631	 NA	 90.00	Deg	 0.150	m	 25.40	mm	 25.40	mm	 46.0	C	

5	 B-3	*	 Bend	 0.9631	 NA	 90.00	Deg	 0.200	m	 25.40	mm	 25.40	mm	 46.0	C	

6	 E-2	*	 Expansion	 0.9743	 NA	 NA	 NA	 25.40	mm	 95.00	mm	 46.0	C	

 
The Results Report is presented as Figure 24. The user can check the Case 2 results by 
printing the Results Report form the File menu. 
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Figure 24: Case 2 Results Report 

 
 
 
 
 
 
6.3 Test Case 3 
 
Test Case 3 is a check of the splitter module. All of the entry fields and results are presented 
on the Splitter form. The user can verify that the splitter module is working proper by 
entering a splitter with a 65° bifurcation angle and an Inlet flow rate of 85 LPM. The results 
should match all the values in Figure 25. 
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Figure 25: Case 3 form 

 


